
The South Bay Mug

A personal view from Bob

Protect yourself

’ve recently had to dump a couple of my email ad-

dresses because they were overwhelmed by spam. 

In the old days I didn’t worry too much about protect-

ing my address, but now spam is a big problem and 

I’m much more careful. I’ve discussed many of these 

steps before, but a review doesn’t hurt.

• Have several addresses. Use one for close friends 

and others for doing business on-line. Be prepared to 

eventually jettison them if they get infested.

• Use jetable.org to create temporary addresses for use 

with outfits you don’t trust.

• If you have a web page, encrypt the addresses. 

Spammers use robots to routinely comb web pages 

looking for addresses. I used SpamStopper which 

converts an email address with it’s telltale mailto: 

and @ into an text string or a java applet. Since I still 

get a little spam, I suspect some spammers may have 

figured a way around this approach.

• I now use a graphic for addresses on my sites. This 

requires the spammer’s robot to use an optical char-

acter recognition (OCR) procedure to retrieve text 

from the graphic. Unfortunately the viewer can no 

longer click the address to send you mail. They have 

to type it in. Use a font that 

may give the OCR soft-

ware a bit more trouble.

• Some people try to hide an email address by elimi-

nating telltale clues, e.g. member_at_ISP_dot_com, 

hoping the readers understands this and can enter the 

correct address. 

• Beware of PDF files. Spammers can scan the con-

tents of a PDF file, so don’t put your email address in 

it unless it’s a graphic. My articles are posted on our 

web site as PDF files but I have my address as a 

graphic element (see bottom right).

• All this is for naught if your friends don’t protect 

your address. When sending an email to a group, put 

the addresses in the bcc: (blind carbon copy) box so 

the recipients won’t see the addresses. Otherwise, if a 

recipient has their computer compromised, the list 

may fall into the hands of a spammer.

• Pick a more obscure email address. bob@isp.com, 

joe@isp.com, jim@isp.com and mary@isp.com are 

obvious targets for dictionary spammers. 

joemary007@isp.com is less obvious.

• Look on the Internet (e.g. Google) for your email 

address. You may find someone has put it on their 

web page. I wrote a software review and found that 

the publisher added it to their web page as a testimo-

nial, along with my email address. Great! I was un-

able to contact them to have it removed. While 

you’re there, check your telephone number. Unless 

it’s unlisted, a cell phone or or you opt out, Google 

will display your name and address. This may be OK 

and does help people trying to find you. Also check 

your social security number.

• I use MyPopBarrier (see Dec 06) to scan my mes-

sages on several servers and delete spam on the spot, 

rather than downloading it to my computer.

• Thwart Web Bugs. Spammers put hidden HTML im-

age requests in their messages to see when you read 

it and to confirm your email address. Turn it off in 

the preferences. You can always load images manu-

ally if they look legit.

I
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Welcome to
South Bay Apple Mac User Group

You and your friends are invited to attend our next meeting.
Our membership dues are only $35 per year, entitling you 
to this newsletter each month and many more benefits.
If you would like to become a member or get more info on 
SBAMUG, feel free to check out our web site at:   
www.sbamug.com

Meetings are held at the
Redondo Beach Community Center

320 Knob Hill, Redondo Beach
(see map & directions on page 11)

Officers & Volunteers:
President:................Glen Terry

Vice President:...........John Bernardo

Secretary:................Wayne Inman

Treasurer:................CW Mitchell

Directors at Large:.......Dave Nathanson,

CW Mitchell, Jim Pernal, Dorothy Weeks, 

George Kiefer, Louise Polsky, Chuck Mulvey

Membership Director:......CW Mitchell

WebMaster & User Group Ambassador:

..........................Bob Brooks

Server Director:..........Dave Nathanson

USPS Liaison:.............Don Myers

PD Disk Editor:...........Jim Pernal

Program Director:.........George Kiefer

Newsletter Editor:........Dorothy Weeks

Raffle Chairman:..........George Griffiths

Refreshment Coordinator:..Louise Polsky

Membership Report:
(You may notice your name is in larger letters 

on your card. That is so it can be used as a 

name tag at the meetings.

Your Membership Cards are in the mail!) 

Current Membership - 172

Welcome new members: 
Rose Tashima, Bill Dufresne.
Thank You Member Renewals - 

Henry Tuttle, Gerry Suzuki, Michael 
Maiuri, Gary Thompson, Russ Neglia, 
Sheila Dowst, Jack Pearson, Hank 
Folson,  Wayne Inman, Paul Bauer, Donna 
Worch, Stephen Woodward, Carol 
Woodward, John Stauffer.
Remember, if your name is not spelled right or  

your expiration date is wrong, contact 

cwmitchell@sbamug.com for correction.

                

!

                                         MONTHLY CALENDAR
1st Sat - SBAMUG Core Group Mtg @ announced locations, 10 am

   1st Thur - LB Mug @ Emerson School,  Palo Verde & Willow, Long Beach, 7 pm
1st Sat - Orange Apple UG, Orange Coast College, Chem Bldg, Costa Mesa, 8am-1pm
3rd Sat - Adobe Tech Exchange Toyota Bldg on Grammercy near 190th, 9 am; $10
Last Wed - SBAMUG Monthly Meeting
Last Tues - WOCMUG @ Emerson School,  Palo Verde & Willow, Long Beach, 7 pm
Last Sat - TRW / Northrop Ham Radio & Computer Swap Meet, 7 am - 11:30 am

The SOUTH BAY MUG (ISSN 1058-7810) is published monthly for $35.00 per year by South Bay Apple Mac User Group,
2550 Via Tejon, Suite 3J, Palos Verdes Estates, CA 90274. Periodicals Postage Paid at Palos Verdes Peninsula, CA and at additional 
mailing offices. POSTMASTER: Send address changes to THE SOUTH BAY MUG, P.O. Box 432, Redondo Beach, CA 90277-0432.

The South Bay MUG is published by the South Bay Apple Mac User Group (non-profit).  Excerpts may be reprinted by user groups and 
other non-profit media. Credit must be given to SBAMUG and the author. In addition, a copy of all reprinted materials must be sent to us 
at the address listed above. The South Bay MUG is an independent publication not affiliated or otherwise associated with or sponsored 

or sanctioned by Apple® Computer, Inc. The opinions, statements, positions and views stated herein are those of the author(s) or 
publisher and are not intended to be the opinions, statements, positions or views of Apple® Computer, Inc.

Members are invited and encouraged to submit articles and original artwork for publication. Newsletter 

deadline is the last Wednesday of the month. Articles may be edited to fit in available space. 

Please send to: dhweeks@sbamug.com 

P. O. Box 432
Redondo Beach, CA
                90277-0432

310-644-3315
Email: info@sbamug.com



SBAMUG July 2007 PD CD

Full nine items this month. Some updates, many

new, including Wordservice, which came up in

our eGroup to solve a problem.

Bookdog_4_2.dmg  Manage your bookmarks.

Yes this can alphabetize your bookmarks; as was

discussed at our last beginners group.  This can

move your bookmarks between your different

browsers.  Firefox, Camino, Opera, and, of

course, Safari are mentioned.  Maybe some

more. You can also have the program verify your

bookmarks to make sure they’re still good. OSX

10.3.9 is the minimum requirements.

CAPSWarn3.1.zip  A utility to give on screen

indications of having your Caps lock on, or shift,

control, option, command keys activated by

sticky keys.  OS 10.3 is the minimum system.

ClamXav_1.0.8_Tiger.dmg Latest update to

this antivirus program.  ClamXav is the graphical

front end to the open source ClamAV program.

As I’ve stated many times, this is good so you

don’t pass along a Windows virus, as well as

someday in the future catching a Mac OSX virus

in the wild.

debtinator-1.dmg.zip A program to manage

debt. Visual graphs to show what’s happening

with your various expenses. The program shows

plans to get you out of debt.  OSX 10.4

emailscanner-vers-1.dmg Utility to extract data

from you e-mails and place into a database such

as Filemaker Pro.  OSX 10.3 is the minimum

requirement.

iSpeak It.dmg This is another great

recommendation from Allison Sheridan’s

Nosillacast podcast.  This will convert text from

a variety of programs to either an aiff file on

your hard drive, or directly as a MP3 into your

iTunes library. From iTunes to your iPod if

desired.  PDF’s can be converted if you have the

PDFtoText program. You can go directly to

either Google maps, weather, and one or two

other places and have your request converted

into speech.  Great for catching up on things in

your car or out with your iPod! OSX 10.4

Limited to 1000 words till you pay the shareware

fee.

MacGourmet-2.1.1.dmg This is a updated

version of the recipe organizer.  Scaling, metric

conversions, printing to index cards, and tons

more.  OSX 10.4 PPC or Intel.

stellarium-0.9.0.dmg Planetarium rendering of

the night sky. Different times and locations can

be specified. Complex program that can do a lot.

Ran out of time to look at it further. OS 10.2 and

best of all its Freeware.

WordService.tgz Finally this month is the

program that came up in our email group.  This

has 37 functions to convert, format, or speak

selected text.  The specific request was to add

initial capitals to selected text, from within

Apple’s Keynote program.  This program is

added to the services menu, so you can access it

from within programs. OSX 10.3 and 10.4 PPC

machines.

CD for this month will be at the August meeting

as the July-August 2007 CD.

 Catch you at the July meeting.

Jim Pernal, PD Editor

***************************************

Here’s a great contribution from our eGroup:

I had to take my 87-year-old aunt to the doctor

today as her regular caregiver was visiting family

in Texas for a week. The reason for the visit was

to follow up after a minor stroke/TIA she had on

the 21st when she spent several hours in the ER.

Since I wanted to be sure I had an accurate

description of exactly what had happened, last

Saturday when I was out with my MacBook, I

sat the caregiver down and had her describe what

had happened while I recorded it with iMovie

using the built-in iSight camera. I created a

Quicktime movie from the single clip and played

it for the doctor so he had a first hand description

of what happened. My aunt has dementia and

doesn't remember the event.

Not a particularly polished iMovie production,

but very effective for the purpose.

Joan King SBAMUG



100 of My Favorite Mac Tips!

By Terry White, MacGroup Detroit

In The Finder

1 To quickly rename a file, select it in the

Finder and press the Return Key. Now you

can just type the new name.

2 To “Move” a file from one drive to another,

hold down the Command Key and drag the

file(s) from one drive to the next and it will
move them instead of just copying them.

3 To make an Alias (a pointer) of a

file/folder/app without the word alias on the

end, hold down the Command-Option Keys

while you drag the original to the location
that you want the alias to appear in.

4 To add a document/application/folder to

your Dock, simply drag its icon to the Dock

and when the other icons move over you

can release it. If it’s a document/folder you

have to drag it to the right side of the

divider.

5 You can preview a lot of different file types

by simply switching your window view to

Column view. Once in Column view you

can click on things like QuickTime movies,

MP3’s, etc. and preview them right in the
Finder.

6 To switch Finder Window views from the

keyboard, hit Command-1 for icon view,

Command-2 for list view and Command-3

for column view.

7 Want a faster Mac? Keep as few items on

your desktop as possible. That’s what

folders are for.

8 Use the Window Menu in the Finder to get

to a window that’s buried several windows

back.

9 Change the default application that opens a

file. For example, want your JPGs to

always open in Photoshop instead of

Preview? Select any JPG, hit Command-I

for Get Info and in the Open With area,

choose Photoshop and then click the

Change All button. You can do this for any

file type supported by the application you
want to open it with.

10 Can’t remember if that application you

want to launch is in Applications or

Utilities, just type the name of it in

Spotlight and when it appears, click on it to

launch it.

11 If you launched an app that you decide you

want to keep on the Dock because you’ll be

using it regularly, just hold down the mouse

button on it and choose “Keep in Dock”

from the pop up menu.

12 To quit an Application without bringing the

app to the foreground, just hold the mouse

button down on its icon in the Dock and
choose Quit from the popup menu.

13 To remove an icon from the dock of

something that you’re not going to be using

regularly, drag its icon up off the dock and

let go. Poof, it’s gone.

14 Change your Desktop Picture with a Right

Click (Contextual Menu). Get used to the

term Right Click. If you have a two-button

mouse, the right button is often set to

Contextual Menu (Control-Click). When

you right click on the Desktop you can

choose Change Desktop Background from

the Contextual Menu that pops up. Right

Clicking is supported just about everywhere

in the OS and in your applications. You’d

be surprised at how much time you’ll save.

15 Use the Side Bar for Folders that you’ll

access often. By default the Side Bar con-

tains, Home, Music, Documents, Pictures,

Movies and Applications. However, you

can drag other folders there too. The

advantage of doing this is that you’ll have

one click access to those folders in all of
your Open and Save dialog boxes.

16 You computer feels slow all of a sudden?

See what’s really chewing up your CPU

time by launching the Activity Monitor in

your Utilities Folder.

17 What about Backing Up? Ideally you’d buy

an external hard drive that is at least as

large as your internal drive, download

Super Duper and clone/backup your entire

drive regularly.

However, if you’re not quite ready to be

totally protected (and only God knows why



not?), then at least back up everything in

your Home (the icon of a little house)

folder. This contains all the data YOU have

put on your computer such as your pictures,

music and documents. If it will fit on a

DVD or two, that’s better than no backup at

all.

18 ZIP it before you send it. If you have a

large file or multiple files to send via email,

select them in the Finder and then choose

“Create Archive of….” from the Action

menu at the top of your Finder window.

This will create a .zip file of whatever you

had selected that is usually smaller in size

than the original and is cross platform. Not

all file types will benefit from this. Files
like JPGs are already compressed.

19 Quickly move something to the trash

without dragging. Select what you want to

trash and hit Command-Delete on your

keyboard.

20 If you are having a hard time finding the

same file/folder all the time in a long list of

items in a window, give it a color label so
that it stands out.

21 Spotlight finds everything with the name

you key in. To narrow it down to just the

kinds of things you’re looking for, put a

“kind” after the name you’re searching for.

ie. iPhone kind:email would only bring up

email messages containing the word
iPhone.

22 Rearrange the items on your Dock in the

order you want by simply dragging them to
the left or right.

23 Customize your Finder windows with

actions/buttons. Right Click on the top of

any Finder Window and choose Customize

Toolbar. You’ll then get a choice of actions

such as New Folder, iDisk, etc. to drag to

your toolbar at the top of the Window.

24 When you have a long list of items in a

Finder window, rather than scrolling to

what you want, just start typing the name of

what you want and the Finder will take you

to it. Simply hitting the letter T will jump

down to all the pictures of me that you have

in that folder.

25 Run a slideshow in the Finder. Select the

photos you want to view and then choose

Slideshow from the Action menu. When

you’re done viewing your full-screen

slideshow press the Esc key.

26 Mac OS X Tiger has a built-in dictionary.

Highlight a word in just about any app and

hit Ctrl-Command-D and the definition of
that word will appear below it.

27 Use Front Row without the remote. If your

Mac is Front Row enabled, hit Command-

Esc to bring up Front Row. You can use

your arrow keys to navigate and the Return

key to choose a selection. Hit Esc when

you’re done.

28 Take a screen shot to prove your point. Hit

Command-Shift-3 to take a picture of the

whole screen or Command-Shift-4 to take a

picture of a selected area. The pictures will

appear on your desktop.

29 Copy and Paste instead of drag and drop.

Sometimes it’s easier to select a file/folder

and hit Command-C and then navigate to

where you want to copy it to and hit

Command-V for Paste, than dragging and
dropping.

30 If you want to open a file in a specific

application, drag it to the icon of the app
you want to open it in on the Dock.

Mail

31 To email some web page, bring up the page

in Safari and hit Command-I and Mail will

create a new message containing the web

page you were viewing in Safari complete

with hot links.

32 View your attachments that you’re sending

as icons. Right click on an attached photo
for example and choose View as Icon.

33 Downsize your attached photos before you

send them. Create a new message, drag in

all the photos you want to send, then choose

Small, Medium or Large from the Image
Size popup at the bottom of the window.

34 To send the same email you just sent to

other people (that you forgot the first time),

choose the message in your Sent folder and

choose “Send Again” from the Message



menu. Then just address it to the folks you
forgot.

35 How much space is your mail taking up on

the server? Choose Get Info from the

Action Menu at the bottom left corner on

the Mail window.

36 Delete a corrupted message from your POP

mail server. Use the steps above to show

the messages on the server, then find the

offending message, click on it and hit the

Remove from Server button.

37 See all your Unread mail from multiple

accounts in one place. Create a Smart

Mailbox called “Unread” with the action of
“Message is Unread”

38 Create a Smart Mailbox of all your OLD

mail. Use the action “Date Received is not
in the last ___ days”

39 See what Mail is really doing by bringing

up the Activity Monitor – hit Command-0

40 Instead of forwarding a message intended

for someone else use the “Redirect”

command instead. This way when the

person you send it to hits reply, they’ll be

replying to the original sender.

Dashboard

41 Hit F12 on your keyboard to bring up

Dashboard. You can also set a button on

your Mighty Mouse to do it as well – such

as the scroll nipple

42 You can have multiple copies of the same

Widget display with different settings. For

example, I have 6 Weather widgets

displaying the weather in various locations

that I frequent.

43 Close widgets you don’t use to conserve

RAM. Bring up Dashboard, then hold down

the Option key and a little “X” will appear

next to each widget that you hover over.

44 To change a widget’s settings click the little
“I” in the corner of the widget.

45 To get more widgets, click the big + sign in

the lower left corner and then click manage

widgets to bring up the Widget Manager.

At the bottom of the Widget manager is a

button called “more widgets” which will

take you to Apple’s website to search for

and download new widgets. There are over

a thousand to choose from.

iTunes 7.x

46 Drag songs from iTunes to a folder on your

desktop to make a copy of the songs in one
spot.

47 Take advantage of audio and video

podcasts! They’re FREE! Go to the iTunes

store and click on the Podcasts category.

Find the podcasts you’re interested in and
subscribe to them. No iPod is required.

48 Want to tell someone exactly which song

you’re referring to? Find the song in the

iTunes store, Right Click on it and choose

Copy iTunes Store URL and then paste that

URL in a new email message. When they

click it, it will take them right to the same
song in the iTunes store.

49 Use the My Rating feature to give your

favorite songs a 1 through 5 star rating.

Ratings can be very useful in creating

Smart Playlists.

50 Create a Smart Playlist of the  “Best of the

Best” by having it automatically add any

song with a 5 star rating.

51 Create a Smart Playlist containing songs

with a play count of ZERO and call it

“never played”. Each time a song is played

from this list it will automatically be

removed from this Playlist. This way you

have a Playlist of never before heard music

at all times.

52 Figure out which songs you don’t really

like by Creating a Smart Playlist with the
criteria of skip count greater than 5.

53 If you don’t want to buy songs/content from

the iTunes store right away, but you don’t

want to lose the tracks you’ve chosen,

change your iTunes Store Preferences to
Buy using a Shopping Cart.

54 Drag tracks right from the iTunes store into

your Playlists. Whenever, you do decide to

buy them, they’ll automatically be in the

Playlists you wanted them in.

55 If you have the same music on two Macs

you can Export and Import your Song List



(Playlist).

56 If you import songs into iTunes from an

Audio CD while you’re on the road without

an internet connection, you can have iTunes

lookup and add the song names later by

choosing “Get CD Track Names” from the
Advanced menu.

57 When you type into the Search box on the

top right of the window you can clear it

with one click by clicking on the “X” next

to what you typed.

58 Now iTunes has 3 different views: List,
Album View and Coverflow

59 Missing Album Art for a CD that you

imported? Apple now provides Album Art

for Free on Albums they have. Select your

tracks in iTunes and choose Get Album

Artwork from the Advanced Menu. If they

have it, then it will download and apply to
your tracks.

60 If you are going to import a bunch of CDs

into iTunes you can change your “On CD

Insert:” preference to “Import Songs and

Eject”. This will automatically get the track

names, convert the songs and eject the CD

when it’s done.

61 They say to remain healthy that we should

do some activity (such as walking) for 30

minutes a day. If you have an iPod or if

you’re going to workout at home, create a

Playlist with songs totaling 30 minutes.

When the music stops, you can hit the

showers.

62 Switch to the next song even if iTunes is in

the background by holding down on its icon

in the dock and the iTunes menu will pop
up.

63 Sometimes songs start out or end with

talking or other sounds that you may not

desire. You can trim the beginning or the

end of a song by highlighting it, hitting

Command-I and clicking Options. From

there you can set the Start and or Stop times

that you desire to skip past the intro or

ending.

64 You can set an Equalizer Preset for each

song by highlighting the song and hitting

Command-I. Click Options and set the

Equalizer Preset for the song you just
highlighted.

65 You can Change the order of the columns

in iTunes by dragging on the Column
headings.

66 Create a Smart Playlist of your favorite

songs, by setting the options to “Play

Count” is greater than 10 (or whatever).

Only the songs that you listen to often will
be in the Playlist.

67 Locate the actual song/video in the Finder

by selecting the track in iTunes, Right Click

on it and then choose Show in Finder from

the contextual menu.

68 Click the Green button in the top left of the

iTunes window to minimize iTunes down

the smallest possible window to take up less
screen real estate.

69 Hit Command-Up Arrow and Command-

Down Arrow to increase or decrease the
iTunes volume.

70 Press the Space Bar to start or stop

playback of a tune.

Safari

71 Safari supports Tabbed Browsing, but you

have to enable it in the Preferences. End the
window clutter!

72 Hitting Command-1 on the keyboard will

go to the 1 web site in your Bookmarks

Bar. Hitting Command –2 will go to the

next one, so forth and so on.

73 Holding down the Command Key while

clicking a folder will open all the book-

marked pages in their own tab (Provided

that you have enabled tab browsing in the
Preferences).

74 Choosing “Status Bar” from the View menu

will put the Status Bar at the bottom of your

browser window so that you can see the

status of pages as they load.

75 You will know that you are on a Secure

Page if you have the Padlock icon in the

upper right corner of your browser window.

76 Create a folder in the Bookmarks pane and

then drag your daily favorites sites into that

folder. Now you can open your daily



favorites in tabs by Command-clicking on
that folder in the Bookmarks Bar.

77 Not every site works in Safari. So

download Firefox which is another browser

and it’s free. Most sites that don’t work in

Safari, work fine in Firefox.

78 To quickly view images on your desktop

without having to open another program,

simply drag them into an open Safari

window.  Safari can load any jpg image

even it’s on your hard drive.

79 Add a bookmark to the Bookmark bar by

dragging the page icon from the address

box to the bar.

80 Remove a bookmark from the Bookmark

bar by dragging the bookmark off the top of

the bar.

81 Scroll up, down, left, or right by pressing an
arrow key.

82 You can open a page in a new window by

pressing Command + click a link or
bookmark.

83 Safari can remember your passwords for

most sites. You can turn this feature on in
the Preferences in AutoFill.

84 Block those annoying pop-up ads by

choosing “Block Pop-up Windows” from
the Safari menu.

85 To see a downloaded file in the Finder,

click the icon next to the file in the Down-
load window.

86 Command  + and Command – will increase

and decrease your view magnification of
the current web page.

87 Protect your privacy by temporarily

stopping Safari from caching or keeping

track of the sites you visit. Enable “Private

Browsing” from the Safari menu.

88 Set your favorite page to be your home

page in the Safari Preferences and then add

the “Home” button to the tool bar by
choosing “Home” from the View menu.

89 Rearrange the order of your Bookmarks on

the Bookmarks Bar by dragging them
around.

90 If you want the current page you’re on to

become the Snap Back page, press Option-

Command-K

iCal

91 Click and drag on a time slot to create an

event.

92 If your life goes beyond 8AM and 6PM

have iCal show you more of the day by

going to the preferences and changing your

Day Start and End Times. See what you’ve

been missing!

93 If you leave iCal open it will automatically

change the icon in the dock to the current

date each day.

94 Keep up with what’s happening in the local

Mac community by subscribing to our iCal

webcal://ical.mac.com/mac-
groupdetroit/MacGroup.ics

95 Both of our Apple Stores maintain iCals of

their events and classes that you can

subscribe to by going to

http://www.apple.com/retail and finding the
store of your choice.

96 Choose “Address Panel” from the Window

menu to bring up a window with your

Address Book to be able to invite people to

your meetings automatically.

iChat AV

97 If you don’t have any other Macs running

iChat in your house, you can close the

Bonjour window

98 Under the Edit menu, you can now choose

Spelling-> Check Spelling As You Type to

interactively check your spelling while
composing chat messages.

99 Create your own private chat room by

choosing New Chat from the File Menu.

You can then Add in your online Buddies.

They will get invites to join the chat.

100 Change your Balloon color and Font in the
Message pane of the Preferences.

        Editor’s note:

        Now that you’ve read through all these,
        Why not take one a day and master them!



  What is the Best Archival Media to Buy?  
by Scott Armstrong

What brand discs should one buy if they want 

their data to last for years and years?

First, the issue of quality depends upon what kind 

of data you are wanting to store on the disk. Then 

there is the price. If you want to share some 

photos or some data with someone and it doesn't 

have to last a lifetime, then I use the TDK disks 

from Costco. Costco has a "buy one get one free" 

special sometimes. That makes them a great deal. 

I found the TDK disks to be very good. 

I don't ever buy the store brand disks. I have also 

had a lot of problems with the Imation brand of 

disks. 

As for Archival Quality disks there are two 

brands—Mitsui and Taiyo Yuden. They are 

different because they use a Phthalocyanine dye 

or Cyanine dye. This gives the disks a bluish 

green color. The cost of the dye and the process 

of making the disks make them cost more. But, it 

is the dye that makes the disks last a long time, 

therefore Archival.

The Mitsui disks are made right here in the 

United States actually in Colorado. You can 

purchase the disks directly from their online store 

at www.mam-a.com. 

The Taiyo Yuden disks come in two flavors, the 

Premium disks and the Value Line. When disks 

are manufactured, a batch is checked for 

manufacturing defects and quality. If the batch 

passes the quality test then they are sold as the 

Premium disks. If the batch has too many defects 

then the batch is sold as the Value Line at a 

reduced price. Both types of disks are available 

from www.supermediastore .com.

The Taiyo Yuden 16x Silver Thermal or White 

Printable DVD-R disks sell for about 49 cents 

each in the 100 pack. They are usually sold in 2 

50-pack cake boxes. We have purchased the 

value line disks for less than 24 cents each. But 

we bought 300. The value line disks are sold 

shrink wrapped in a stack.

At KVEW we use them to put a :30 second 

commercial on it just for the client to view their 

commercial. So we use the value line just for the 

cost. I couldn't find any brand anywhere cheaper 

than 23 cents each. They play fine for our use. 

However, I made some data backups and had a 

lot of data mismatch errors on verification in 

Toast. So I wouldn't use the value line disks for 

really important data.

The Taiyo Yuden Premium line of disks are 

excellent and I have had no burn errors at all. I 

use the Taiyo Yuden disks for archiving my client 

photos and important computer data for  my 

photography business.

The Taiyo Yuden disks can be made in either 

Japan (the really top quality ones) or Taiwan 

(a lesser grade). When you purchase the Taiyo 

Yuden disks check the white paper at the 

top of the disk stack in the Cake Box; it will have 

English and Japanese type and the words 

"Made in Japan" clearly marked. These are the 

ones to get.

You can also get disks from www.meritline.com. 

But SuperMediaStore has them for less. What 

makes a disk Archival is the dye and the quality 

of the disk manufacturing and the testing 

standards. A disk is made up of 5 layers. The top 

layer that the label is printed on, a lacquer, a 

reflective layer, a dye layer and the bottom 

protective layer. A laser burns or pits the dye 

layer with the digital information. It is the 



stability of the dye layer that makes a disk 

archival. For information on the manufacturing 

process go to the Mam-a website and click on the 

manufacturing link. It's great reading.

Things that can destroy a disk are gouges in the 

bottom layer, alcohol based markers used to write 

on the top layer (such as a Sharpie), or excessive 

exposure to the UV rays and sunlight. The data 

layer is very close to the top layer so a sharpie 

ink can eventually bleed thru to the dye layer and 

make it difficult for the laser to read. Excessive 

sunlight can fade the dye layer and also make it 

difficult for the laser to read. 

The Phthalocyanine dye used in the Mistui disks 

are the most stable dye available. The Cyanine 

dye of the Taiyo Yuden disks come in a very 

close second.

For very important data, use an Archival CD or 

DVD such as those from Mitsui or Taiyo Yuden. 

Use a water based disc marker for making the 

label, keep the disk in a jewel case for protection 

and out of the sunlight and in a moderately 

tempered room. Don't store disks in the garage in 

the heat and cold and don't leave them sitting 

bottom up on a table in the direct sunlight. Don't 

buy generic name or cheap store brand disks.

With good brand disks and correct storage your 

disks should last for decades. Now the problem 

will be reading the old disks in 30 years when 

you don't have a working DVD drive anymore. 

Have fun and happy burning.
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How to Learn the Mac
Bob Brooks

--by way of the SBAMUG eGroup

Be resourceful.

Be curious.

Be inquisitive.

Explore.

Have a positive attitude toward learning 

something new.

Experiment, Experiment, Experiment

For each new program:

    Open the Preference file and see what's there

    Look at each item in the menu bar

         and all the sub-menus.

    Look at each item in the Inspector or 

Formatting palette.

    Understand each tool-bar item.

Often there are tool-tips that pop up when you 

mouse over items.

When you need help, look in the HELP menu. 

There may be a lot of useful information lurking 

there.

    Keynote has a 187 page User Guide plus an 

extensive tour.

    Pages has a 250 page User Guide plus a tour.

    Quicken 2006 has a 445 page User Guide.

You can find a lot of information, tutorials, and 

discussion groups on the Internet.

Take some time. Open a new document and 

PLAY. Nothing will explode if you click the 

wrong button.

Young people learn so fast because they are not 

afraid to experiment and try things. We can learn 

from that, regardless of our age.

Finally: Be RESOURCEFUL

                     



THIS MONTH’S MEETING
Wednesday July 25th, 2007  7:30PM

320 Knob Hill, Redondo Beach
(see map at left for directions)

GREAT RAFFLE PRIZES TOO, TICKETS ONLY $1 EACH!

And Of Course:

Come early (6:30) for Beginners Q & A Sessions! We 

now have two: one in the main hall hosted by Bob 

Brooks & Jim Pernal and the other in the kitchen area 

hosted by LJ Palmer  

August 29th Meeting Details:

Glen Terry will be introducing us to the nooks and 
crannies of iTunes and iPods.More music and 
entertainment - we’ll be dancing in the aisles !

Walt Ordway on Digital Cinema
Walt Ordway,  who  gave us a very informative presentation 

on HD TV, returns to demystify more of the digital world 
with an account of Digital Cinema.

What will this mean for us ? Will the sound and the picture 
be much better, or will the cinema experience change ? Will 

we see different and better films or is there a chance even 
our own creative efforts will make it to the screen !

Note from the Editor

Would you like to help keep our 

SBAMUG going? There are many ways, 

from occasional to ongoing, that you can 

help out. If you can, please contact--

Glen Terry at: geterry@earthlink.net 
or other board members.

We welcome 
your input!

Any comments or ideas for future 

meetings? Write it down and drop it in 

our Suggestion Box at our monthly 

meetings!

Don’t forget we have 

internet access at our 

meetings. Bring your wifi 

capable laptop with you when 

you show up for our next 

meeting!



PERIODICALS

South Bay Apple Mac User Group
P. O. Box 432
Redondo Beach, 
CA 90277-0432

SBAMUG Membership Application
South Bay Apple Macintosh User Group provides Mac owners and users with a local source 

of shared knowledge and experience through monthly meetings, training seminars 
and our monthly newsletter.

Individual and family membership is $35 per year payable to SBAMUG.
! New Member          ! Member Renewal

Name: _________________________________________________________
Address:   ______________________________________________________
City:  ___________________________   State: _________  Zip: ___________
Home Phone: _____________________  Email Address: __________________
Special Computer Interest: __________________________________________
Model of Macintosh You Use Most: ____________________________________
How did you hear about SBAMUG?: ___________________________________
Comments: ______________________________________________________
_______________________________________________________________
Signature: ___________________________    Date: ______________________

Bring Application & Fees to Meetings or Mail to:
SBAMUG

P.O. Box 432
Redondo Beach, CA  90277


